# SIRVA DCR
Document Capture and Recognition

Updated: 1/20/2011

## Table of Contents

- **Overview** ................................................................................................................................................................................. 2
- **Step 1 – Installation** ................................................................................................................................................................ 3
- **Step 2 – User ID, Password, Station ID** .............................................................................................................................. 4
- **Step 3 – Logging into SIRVA DCR** ........................................................................................................................................... 5
- **Step 4 – Selecting a Scan Job** .................................................................................................................................................. 6
- **Step 5 – Scanning Paperwork** ................................................................................................................................................ 7
  - Normal Scanning Procedure .................................................................................................................................................. 7
  - Understanding the Scan Paperwork screen ............................................................................................................................ 7
  - System Generated Scanning Control Sheets (SCS) ...................................................................................................................... 8
    - Creating a Scanning Control Sheet ..................................................................................................................................... 9
  - Scanning Paperwork ............................................................................................................................................................... 9
    - Scanning Paperwork with a Directly Attached Scanner ..................................................................................................... 10
    - Scanning Paperwork with a Multi-Function Device ............................................................................................................. 10
    - Adding Files from a Multi-Function Device ......................................................................................................................... 11
- **Step 6 – Reviewing Scanned Images** ..................................................................................................................................... 12
  - Thumbnail View .................................................................................................................................................................... 12
  - Inserting a Scanning Control Sheet ..................................................................................................................................... 14
  - Finishing Scanning ................................................................................................................................................................ 14
  - Cancelling Scanning ............................................................................................................................................................... 14
- **Step 7 – Uploading Batches** .................................................................................................................................................. 15
- **Step 8 – Batch Status Report** ................................................................................................................................................ 17
  - Understanding Batch Statuses ................................................................................................................................................. 18
- **Troubleshooting** .................................................................................................................................................................... 19
  - Scanner Information ............................................................................................................................................................... 19
  - Resetting TWAIN Connection .................................................................................................................................................. 19
  - Remote Assistance .................................................................................................................................................................. 20
  - Obtaining Assistance ............................................................................................................................................................. 20
Overview

SIRVA DCR is an application for the scanning and transmitting of physical paperwork to the SIRVA Document Imaging System (SISTRS). It was built in order to overcome shortcomings of an existing system, and to allow SIRVA developers to better customize, control and troubleshoot the document scanning process.

The application is designed to acquire images from your scanner (or other imaging device), and if necessary transfer them to the SIRVA Document Imaging system. Only certain jobs require the additional step of uploading the documents scanned. As a general rule, if you are outside of the SIRVA Network, you’ll need to upload your documents after scanning.

Scanning can be performed by either a TWAIN-compliant scanner physically attached to your computer or through the use of a Multi-Function Device (printer/copier/fax machine combinations). While most TWAIN-Compliant scanners and MFDs will work with SIRVA DCR, each can act a bit differently depending on the manufacturer and model and your individual computer setup. This guide will attempt to give the most general and broad usage of both scanners and MFDs, but some steps may not be able to be followed verbatim with all hardware.
Step 1 – Installation

Installation of SIRVA DCR is usually as simple as downloading the application from the internet, and running an installer. The installation package can be downloaded by clicking on this link:

Download SIRVA DCR Installation Package

Alternatively, you can enter this URL into your web browser’s address bar:

http://image.sirva.com/dcr/dcrsetup.exe

**ADDITIONAL NOTE**

Depending on your computer and network setup, the assistance of your IT department may be necessary to install SIRVA DCR. Often, Windows 7 computers require that an administrator install the application instead of the average user. If this is the case, you will be prompted to supply administrator credentials in order to complete the installation. Please contact your IT department.

If you are using a physical scanner, be sure to install SIRVA DCR on the computer that is attached to the scanner.

If you are using a Multi-Function Device, it can generally be installed on any PC. See the Using Multi-Function Devices section for more information.

Once installation is complete, SIRVA DCR is installed onto your PC and you can proceed to Step 2.
Step 2 – User ID, Password, Station ID

In order to log into SIRVA DCR, you’ll need to have a user account created. This user account will identify you and allow us to track your batches during scanning and uploading.

• If you already have a User ID, Password, and Station for DCR, continue onto Step 3.

If you do not have a user account, you will need to contact the SIRVA Customer Support Center to have an account created. In order for the CSC to create your account, they will need to know this information:

1. **Agency Code**
   A 7-digit number that uniquely identifies your agency. For example, ‘1234000’

2. **Number of physical scanners at your location**
   If you are not using scanners, and will be using Multi-Function Devices instead, they’ll need to know how many computers will have DCR installed.

3. **Name of each person who will be scanning**
   For each scanner (or installation), a name will be associated with the Station ID that is created.

4. **Moving Services brands that you will scan paperwork into**
   MS brands could include Allied, North American or International, or a combination of the three.

Contact the SIRVA Customer Support Center at: **1-800-999-5917, option 1.**

The SIRVA Customer Support Center will give you the following information to use to log into DCR. Be sure to write down this information and keep it near the computer that will be scanning:

1. **User ID**
   Your User ID will be the same as your Agency Code

2. **Password**
   a. A random 6-letter password. The password is a combination of lower-case letters and numbers. The password does not expire, and will be used by all stations for a given User ID.

3. **Station ID**
   For each physical scanner you use, you will be given a different station ID. For example, if you have two scanners, you’ll have two Station IDs (1 and 2). It is important for tracking purposes that you be sure to log into different scanners with different Station IDs. If you use Multi-Function Devices, each different computer on which DCR is installed will be a different Station ID.

Once you have received your **User ID, Password, and Station IDs**, continue on to **Step 3.**
Step 3 – Logging into SIRVA DCR

When SIRVA DCR is installed, you can start it one of two ways:

**Double-click the SIRVA DCR Icon that is created on your Desktop**

**OR**

Through the Start Menu:

Click **Start > Programs > SIRVA DCR**, and select the **SIRVA DCR** icon.

When you start DCR, you will be prompted to Log In. Enter your **User ID**, **Password**, and **Station ID**, and click the **Login** button.
Step 4 – Selecting a Scan Job

After logging into DCR, you will arrive at the **Home Screen**:

![Home Screen Image]

To scan any paperwork you’ll need to select a **Scan Job**. *Which* Scan Job you choose depends on what paperwork you’re scanning.

For example,

- If you are going to scan shipment paperwork for Allied, select the **Scan Allied Paperwork** link.
- If you are going to scan Driver Qualification paperwork, select the **Scan Driver Qualification Paperwork** link.

After selecting a **Scan Job**, you’re taken to the **Scan Documents** screen.
Step 5 – Scanning Paperwork

Normal Scanning Procedure

Normally, the process for scanning documents will be the exact same for each batch scanned. This training guide is laid out in that same order so it can be easily followed. That process is:

1. Login to SIRVA DCR
2. Select Scan Job
3. Create Scanning Control Sheet (if applicable)
4. Scan Documents (either from direct attached scanner or from a Multi-Function Device)
5. Review Scanned Images
6. Finish Scan
7. Upload Batch

Understanding the Scan Paperwork screen

The Scan Paperwork screen provides a lot of information and options to facilitate the scanning of documents.
**Batch Number**
One of the more important things to see is in the upper right corner (Box 1). Each batch of paperwork is identified by a unique **Batch Number**, in the screenshot example, “110117.0081”.

** Thumbnails**
Thumbnails of the images that have been scanned into this batch will appear in the preview window which takes up the majority of the **Scan Paperwork** screen (Box 2). You can change the size of the thumbnails by using the dropdown menu (Box 3).

**Number of Pages in the Batch**
Displays the number of pages in the current batch, including system generated scanning control sheets. Before completing the batch, it is always a good idea to make sure that this number matches what you expect (Box 4).

**Import Method**
Files can be imported either from a directly attached scanner (this is the ‘normal’ method), from a file already created (such as from a Multi-Function Device), or from a folder of existing files (Box 5).

**System Generated Scanning Control Sheets**
A Scanning Control Sheet (often called a ‘Cover Sheet’ or ‘Barcode Sheet’) can be created directly within DCR, preventing the need for printing out a blank form and handwriting information onto it. This functionality is described below (Box 6).

**System Generated Scanning Control Sheets (SCS)**
If the Scan Job you’re currently scanning supports creating a **System Generated Scanning Control Sheet (SCS)**, you will see the **Create Scan Control Sheet** button in the tools frame on the left side of the Scan Paperwork screen (Box 6). Use this to create a Scanning Control Sheet for this batch.

---

**ADDITIONAL NOTE**
Not all Scan Jobs support creating a **System Generated Scanning Control Sheet**. If the job you’re scanning does not, you will **not** see the **Create Scan Control Sheet** button.

A **System Generated Scanning Control Sheet** may be used in place of the hardcopy Scanning Control Sheet that was used to identify the documents in a batch. The SCS that is system-generated is of a standardized format, and contains both identification information about the agency and the paperwork.

While the **System Generated Scanning Control Sheet** is the preferred method, you may continue to use your hard copy SCS sheets.

*All batches must contain a Scanning Control Sheet.*
Creating a Scanning Control Sheet

To create a Scanning Control Sheet, press the Create Scan Control Sheet button on the Scan Paperwork screen. A new window is opened allowing you to both create a print the Scanning Control Sheet.

![Scanning Control Sheet](image)

You’ll be presented with text fields to create a Scanning Control Sheet that identifies the paperwork in the batch. In the case of Moving Service Allied/NAVL paperwork, the only data you need to enter is the Order (or Registration) number.

You can also choose to Print the scanning control sheet that is created so that you can save it with the paperwork after the batch is scanned. Printing the Scanning Control Sheet is optional.

To Print the Scanning Control Sheet, select the Print Scanning Control Sheet option, then select which printer you want to use in the Printer dropdown.

After you have entered the required information to create the Scanning Control Sheet, click the OK button. The Scanning Control Sheet will be added to your batch (you’ll be able to see it in the Thumbnail Preview area) and, if you opted to print the Scanning Control Sheet, it will also be printed at this time.

Scanning Paperwork

There are two common ways to scan paperwork into DCR:

- A Scanner directly attached to the computer
- Using a Multi-Function Device to scan paperwork to a network location

If you are going to scan paperwork with a scanner directly attached to the computer, read the Scanning Paperwork with a Directly Attached Scanner below.

If you are going to scan paperwork using a Multi-Function Device, skip down to Scanning Paperwork with a Multi-Function Device.
Scanning Paperwork with a Direct Attached Scanner

This is the most common and straightforward way to scan paperwork. The DCR application will communicate with the scanner and pull the pages through, creating images of them in the batch.

Prior to scanning, be sure the documents are loaded into the scanner, all staples and paperclips are removed, and the documents are facing the correct direction.

To begin scanning, select your scanner from the Scanner dropdown then click **Scan Now**. Normally, you’ll see a small dialog appear, showing you that pages are being fed through the scanner. Depending on your model of scanner, this may not appear, but the scanner should start scanning pages regardless.

As pages are fed through the scanner, thumbnail images will appear in the **Thumbnail Preview** area, showing you images as they are received.

Scanning Paperwork with a Multi-Function Device

A Multi-Function Device (copier/printer/fax machine) is often connected to your network, which allows it to act as a scanner, but instead of scanning directly to DCR, it scans the paperwork to a file which must then be imported into DCR.

Since each make and model of Multi-Function Device is different, it’s difficult to provide a guide to set it up correctly, but these are guidelines to follow:

- **Scan** should be in **Black and White** (bi-tonal). Color and even grayscale images are unnecessarily large. These larger images will be slow to upload, recognize and view once imported into SISTSRS.

- **Scan Resolution** should be set to a minimum of **200 DPI**, but as close to 200 as possible.

- **Output file type** should be a **TIFF image**. Nearly all Multi-Function Devices can output TIFF images. If your device does not support TIFF images, a PDF will work as well, but a TIFF is by far preferred.

In order to configure your MFD, you may need the assistance of your IT department or the instruction manual of the device.

Often, configuring the MFD to save the images it creates to a network location that the computer can see is the easiest method. This allows DCR to read that file directly into the batch.

Alternatively, it is possible to use the email capability of the MFD (if it exists) to email the TIF image to the user doing the scanning. They can then save the attachment from their email to a location on their local machine and access the file this way. Naturally, since this adds additional steps, scanning to a network location is usually preferred.
Adding Files from a Multi-Function Device

Once the paperwork has been scanned on the MFD and the image saved, the next step is to import that image into DCR. Instead of selecting a scanner in the From Scanner tab on the Scan Paperwork Page, select the From File tab, as shown on the left.

To import the file, click the Browse for File button then find and select the file; its path and name will be put into the File Location box. Once selected, click the Add File button to add the file to the batch.

Since most scans will be multiple pages you’ll receive a message like the one to the side indicating that the file you’ve selected is multiple pages and needs to be converted into single pages – this is expected.

Click Yes, and the pages will be extracted from the file and added to the batch.

‘DELETE SOURCE FILE WHEN FINISHED’

If you no longer need the file that was created by the MFD after importing it into DCR, you can select the Delete Source File when Finished box. If selected, when you click Finish Scan, the original file (that came from your MFD or other source) will be deleted. Only use this option if you are certain you no longer require the original file.

Using this feature can help keep folders clean of old files, preventing the mistake of accidentally opening an older scan or having to search through a large list of files, but if used incorrectly, can delete files not intended to be deleted. Use with caution.
Step 6 – Reviewing Scanned Images

Thumbnail View

After your images have been scanned (either by a Scanner or Multi-Function Device), it is important to review the images to make sure they’re clean and accurate. The images are available as thumbnail previews, which can be magnified and manipulated as needed.

The Thumbnail Preview section lets you do a preliminary review of the images by viewing a small version of the image. For each batch, you should:

- Make sure the images aren’t too dark or light, and don’t show any splotches, black lines (which often indicates dirt on the lens of the scanner) or other imperfections.

- Check the **Number of Pages** in the batch in the lower-right corner of the thumbnail preview window. In the example above, there are 13 pages in the batch: 1 System Generated Scanning Control Sheet and 12 scanned pages.
To view the thumbnails in greater (or less) detail, you can change the size of the thumbnail images by selecting the **Thumbnail Size** dropdown menu in the lower-left corner of the preview area, selecting Small, Medium or Large.

If you need to view a page in much greater detail, you can **double-click on the thumbnail** to view a full-size image of the page.

From the detail view, you’re able to view the page in much greater detail than the thumbnail view allows. The **Toolbar** above the image allows you to manipulate the view and image as need be. With the buttons on the toolbar you can:

- Expand the view to the entire width of the window in order to view more detail
- Mirror the image horizontally
- View the entire image
- Flip the image vertically
- Rotate the image to the left 90 degrees
- Delete the page
- Delete the page If deleted, it cannot be recovered. It will need to be rescanned
- Rotate the image to the right 90 degrees
- Go back to viewing thumbnails
- You can also go back to the thumbnails by double-clicking on the image

From the detail view, you’re able to view the page in much greater detail than the thumbnail view allows. The **Toolbar** above the image allows you to manipulate the view and image as need be. With the buttons on the toolbar you can:

- Expand the view to the entire width of the window in order to view more detail
- Mirror the image horizontally
- View the entire image
- Flip the image vertically
- Rotate the image to the left 90 degrees
- Delete the page
- Delete the page If deleted, it cannot be recovered. It will need to be rescanned
- Rotate the image to the right 90 degrees
- Go back to viewing thumbnails
- You can also go back to the thumbnails by double-clicking on the image
Inserting a Scanning Control Sheet

If you forget to add a System Generated Scanning Control sheet before scanning paperwork, or need to separate different groups of paperwork in your batch, it is possible to insert multiple scanning control sheets throughout the batch.

To do so, right-click on the thumbnail where you want to insert the Scanning Control Sheet (it will be inserted before the selected thumbnail) then select the Insert Scan Control Sheet menu item (See screenshot to the left). For example, if you right-click on page 12 to insert a scanning control sheet, the new scanning control sheet will be placed in front of page 12.

This can allow you to scan multiple sets of paperwork within the same batch, and then insert scanning control sheets after the fact.

If the scanning control sheet was not placed correctly, right-click on the thumbnail and select Delete Page to delete it and try again.

NOTE: Be very careful to insert them in the correct location.

Finishing Scanning

After reviewing the scanned images and finding them acceptable, the scanning process is complete and you can finish the process by clicking the Finish Scan button.

This will save the batch to your system, and set it ready for uploading. At this point, the scanning portion of this batch is finished, and you can move onto Step 7 – Uploading below.

Cancelling Scanning

For whatever reason, if you need to cancel scanning a batch, click the Cancel Scan button. Any pages scanned (or imported from files) will be lost, and will need to be rescanned.

Any files added using the From File method with the Delete File After Scan option selected will not be deleted. They will only be deleted when the scan is Finished, not Cancelled.

If the scan is cancelled, return back to Step 4 – Scan Job.
Step 7 – Uploading Batches

Many Scan Jobs require that images be uploaded after scanning. Uploading is the process of transferring the scanned images to SIRVA. Images cannot be processed or imported into the SISTRS system until they are uploaded. Most jobs will list ‘Requires Upload’ next to the scan job link in order to remind you.

Another reminder is the Batches Pending Upload section that appears on the Home Screen. When batches are pending upload, they will appear in this list, along with the number of pages in the batch. If you attempt to exit DCR before batches are uploaded, you will be reminded and asked if you want to upload them before you exit.

Multiple batches can be queued for upload. During the upload process, all queued batches will be uploaded in order.

To begin the process, click the Upload Batches button.
As each batch’s pages are uploaded, a preview of the page will appear on the right side. The Batch Progress bar will show the progress of the current batch (how many pages have been uploaded compared to how many pages are in the batch), while the Overall Progress bar will show the progress of uploading all batches (how many batches are to be uploaded).

Uploading will run without any intervention from you unless a problem occurs. If a problem does occur or you cancel uploading by clicking the Cancel Upload button, you’ll be notified that the current batch was not uploaded. You’ll be asked whether or not you’d like to attempt uploading the batch again. If you choose “Yes”, the batch will return to the Batches Pending Upload list. If not, the batch is lost and must be rescanned.

Once all batches are uploaded, you’ll be able to close the Upload Screen, and return to the Home screen.

---

**ADDITIONAL NOTE**

Once the batch has been uploaded successfully, your scanning has been completed. From then on, the paperwork will be processed by the DCR system and then imported into SISTRS. This process can take from several minutes to several hours.
Step 8 – Batch Status Report

The Batch Status Report is available for you to track of the status of each of the batches your station has scanned. You’ll be able to track and print a report displaying the status of any batch you’ve scanned in the past 30 days.

To access the Batch Status Report, use either the Tools menu or the Batch Status Report button. Both are located on the Home Screen.

Choose between the different date ranges provided (default is Today) then click View Report to generate your Batch Status Report. Clicking on the blue information icon next to each batch will describe the meaning of the status of that particular batch.

The Batch Status Report is generated with a list of all the batches scanned (successfully and otherwise) within the selected date range. The report displays the following information for each batch:

- **Date/Time** – The date and time the batch was scanned
- **Batch Number** – The batch’s unique number
- **Pages** – The number of pages scanned in this batch
- **Status** – The status of the batch; its current state at the time the report was generated

To Print the Batch Status Report, click the Print button.
Understanding Batch Statuses

The batch’s status will continually change as it moves through the system. There are four possible “main” states the batch can be in:

- Scan
- Upload
- Recognition
- Finished

For each of these states (with the exception of Finished) the batch is also identified as being:

- Pending
- Running
- Aborted
- Cancelled

For a ‘normal’ batch, when you first start scanning, the batch will go through these standard state changes:

- When you first start scanning the batch, it is set to a state of Scan Running.
- When you finish scanning, it is set to Upload Pending.
- While the batch is uploading, it is set to Upload Running.
- When the batch is finished uploading, it is set to Recognition Pending.
- While the batch is being recognized, it is set to Recognition Running.
- When recognition is completed, it is set to Finished.

If you cancel the batch during the Scan or Upload process, the batch is set to Scan Cancelled or Upload Cancelled respectively. Any batches in this status need to be rescanned, as the process did not finish.

If an error occurs during the scan or upload process, the batch is set to Scan Aborted or Upload Aborted, respectively. Any batches in this status need to be rescanned, as the process did not finish and paperwork was not sent to SIRVA.

---

**RECOGNITION ABORTED**

If an error occurs during the recognition process, the batch’s status will be set to Recognition Aborted. The batch does not need to be rescanned. If a batch errors during recognition, SIRVA IT staff will investigate and resolve the issue.
Troubleshooting

Scanner Information

The Scanner Information screen is meant for troubleshooting and support use. It will determine which settings and configurations your particular scanner allows in order to troubleshoot errors and issues.

Resetting TWAIN Connection

Sometimes it is necessary to reset the connection between SIRVA DCR and the scanner. To do this, go to the Home screen, select the Tools menu, and Reset TWAIN Connection. This will reset the connection to your scanner.

If this does not resolve the issue then you can try Reset TWAIN Connection (Forceful). This performs the same reconnection as the other, but is more forceful in how it resets. If the scanner does not respond to the normal reset, sometimes this will bring it back online.
Remote Assistance

If you’re not able to resolve an issue on your own, it’s often much easier for technical support personnel to troubleshoot the issue if they can interact with your PC directly. To do this, they’ll ask you to go to the Tools menu, and select Remote Assistance. This will allow them to connect to your computer and interact with your desktop for troubleshooting purposes.

**REMOTE ASSISTANCE PRIVACY**

During a Remote Assistance session no identifiable information, passwords or secure information is transmitted. Support personnel only see and interact with your desktop.

Obtaining Assistance

If you are experiencing difficulties with or have questions about SIRVA DCR, you can contact the SIRVA Customer Support Center at:

1-800-999-5917, option 1.